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The HP Connectivity Kit

Introduction
The HP Connectivity Kit is a software application 
designed to help you create and manage data for your 
HP graphing calculator. There are specialized editors for 
creating and editing lists, matrices, notes, and programs. 
You can also view all the real variable values (A-Z and ) 
at the same time and edit any of them. Likewise, you can 
view and edit all the complex variables Z1-Z9 and Z0.

Getting started
To use the HP Connectivity Kit, follow these steps:

1. Connect your HP graphing calculator to your PC 
using the USB-to-miniUSB cable that came in your 
product package. The USB end of the cable plugs 
into your PC and the miniUSB end plugs into your HP 
graphing calculator.

2. Turn on your HP graphing calculator.

3. Go to the Start menu on your PC, locate the HP 
Connectivity Kit folder, and launch the HP 
Connectivity Kit application.

θ
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2 The HP Connectivity Kit

The HP Connectivity Kit application window has 5 parts 
as shown in the figure below:

1. The menu bar at the top.

2. The icon bar below the menu bar.

3. The calculator pane on the left below the icon bar.

4. The editor pane on the right below the icon bar.

5. The status bar at the bottom.

When you launch the HP Connectivity Kit with your HP 
graphing calculator attached, the HP Connectivity Kit 
copies your calculator data (lists, matrices, programs, 
etc.) to the calculator pane on the left. The calculator 
pane will show an icon for your calculator and the status 
bar will show the message, Ready. The editor pane will 
be empty as no calculator objects have been selected for 
editing. The HP Connectivity Kit is designed to allow you 
to edit your calculator data objects and create new ones, 
as well as to save the new data objects back to your 
calculator. You may use the new or edited objects on your 
attached HP graphing calculator (run programs, etc.), but 
any changes you make to the data on your HP graphing 
calculator after launching the HP Connectivity Kit will not 
be recognized by the HP Connectivity Kit. If by mistake 
you edit the data directly on your HP graphing calculator, 
you will have to disconnect the calculator, close the HP 
Connectivity Kit, and restart the application as well as 
reconnect the calculator in order for those changes to be 
recognized by the HP Connectivity Kit. The next two 
sections describe the menu and icon bars.

Menu bar

Icon bar

Calculator
pane

Status bar Editor pane
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The menu bar
The menu bar contains the following familiar menu items:

• File

• Update

• Help

The File menu The File menu contains options for managing the 
application.

• Check for Updates: checks for updated versions of the 
application and the calculator software

• Language: choose a language for the application

• Exit: closes the application

The Update 
menu

The Update menu contains two items:

• Update Calculator: manually updates the HP 
graphing calculator software

• Format & Update Calculator: formats the calculator 
flash memory and then manually updates the 
software

The Help menu The Help menu gives you access to this documentation as 
well as version information.
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4 The HP Connectivity Kit

The icon bar
The icon bar contains the following standard icons:

• Save: saves the data in the current editor to the 
attached HP graphing calculator

• Cut: cuts the selected data from the current editor and 
places it in the clipboard

• Copy: copies the selected data from the current editor 
and places it in the clipboard

• Paste: pastes the clipboard contents into the current 
editor, starting at the current cursor location

Connectivity_Aspen..fm  Page 4  Wednesday, August 1, 2012  9:08 AM



The HP Connectivity Kit 5

Using the editors
To view and edit data on your calculator, click on the plus 
sign icon (+) to expand the list of calculator data object 
types. If you give your HP graphing calculator a name, 
the name will appear next to the icon in the calculator 
pane. To name your HP graphing calculator, simply click 
next to the calculator icon in the calculator pane and type 
the name you want to give your calculator. On the 
calculator, this name appears on the second page of the 
Modes menu. On the calculator, press SH4 
to see the new name. Press H to return to the Home 
view.

Once the calculator icon is expanded, you will see a list 
of six object types:

1. Real, for the real variables A-Z and . 

2. Complex, for the complex variables Z0-Z9.

3. List, for the list variables L0-L9.

4. Matrix, for the matrix variables M0-M9.

5. Programs, for user programs.

6. Notes, for user notes.

The Real, Complex, and List entries each start an editor 
that shows all the variables of that type at once. The 
Matrix entry has a plus sign icon (+) to indicate that it can 
be expanded to edit each of the matrix variables 
separately. If your calculator is new, it will not have any 
user programs or notes, so the last two entries will not 
have the plus sign icon that the Matrix entry has. Once 
you create objects of these types, the icons will appear.

To edit the real, complex, or list variables, simply double-
click on the corresponding entry in the calculator pane to 
open the editor for that variable type. Edit the variable 
values using your PC keyboard. When you are done, 
click on the Save icon in the icon bar, or press Ctrl+S on 
your PC keyboard, to save your changes to the 
calculator. If you wish, you can check the contents of the 
variable(s) on your HP graphing calculator. If you are 
editing a calculator object using the Connectivity Kit and 
have the corresponding editor open on your HP graphing 
calculator to view the same object that you have just 
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6 The HP Connectivity Kit

edited using the HP Connectivity Kit, then you will have to 
click on the Save icon in the Connectivity Kit icon bar to 
see the changes reflected in the corresponding editor on 
your HP graphing calculator.

The following sections cover each of the editors.
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The real 
variable editor

Your HP graphing calculator has 27 real variables, 
named A-Z and . To see the values of these variables, 
double-click on the Real entry in the list of your HP 
graphing calculator in the calculator pane to launch the 
real variable editor. This editor is designed to let you view 
the values of all the real variables at the same time and 
to let you edit those values easily. The editor shows the list 
of real variables in a single column on the left and the 
corresponding values of these variables in a single 
column on the right. If your calculator is new, the 
variables are all set to zero. 

Suppose you wish to store 5 in A and 32 in B. Follow 
these steps:

1. Expand your calculator icon in the calculator pane.

2. Double-click on Real in the calculator pane.

3. Click on the cell to the right of A in the editor window 
and enter 5.

4. Use either the down-arrow key to move to the cell to 
the right of B or click on that cell and enter 32.

5. Click on the Save icon in the icon bar to transfer the 
data to your HP graphing calculator.

6. To check your calculator, press AaE in 
the Home view to see 5 and press AbE 
to see 32.

7. When you are done, you can close the real variable 
editor in the editor pane.

θ
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8 The HP Connectivity Kit

The complex 
variable editor

Your HP graphing calculator has ten complex variables, 
named Z0-Z9. To see the values of these variables, 
double-click on the Complex entry in the list of your HP 
graphing calculator in the calculator pane to launch the 
complex variable editor. This editor is designed to let you 
view the values of all the complex variables at the same 
time and to let you edit those values easily. The editor 
shows the list of complex variable names in a single 
column on the left and the corresponding values of these 
variables in two columns on the right. The first of these 
columns contains the real part of each complex variable 
and the second contains the imaginary part of the 
complex variable. If your calculator is new, the variables 
are all set to zero. 

Suppose you wish to store 5+3i in Z1. Follow these steps:

1. Expand your calculator icon in the calculator pane.

2. Double-click on Complex in the calculator pane.

3. Click on the cell to the right of Z1 in the editor 
window and enter 5.

4. Use either the right-arrow key to move to the cell to 
the right or click on that cell and enter 3.

5. Click on the Save icon in the icon bar to transfer the 
data to your HP graphing calculator.

6. To check your calculator, press Az1E in 
the Home view to see 5+3*i.

7. When you are done, you can close the complex 
variable editor in the editor pane.
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The list variable 
editor

Your HP graphing calculator has ten list variables, named 
L1 through L9 and L0. To see the values of these 
variables, double-click on the List entry in the list of your 
HP graphing calculator in the calculator pane to launch 
the list variable editor. This editor is designed to let you 
view the values of all the list variables at the same time 
and to let you edit those values easily. The editor shows 
the list variable names in a single row at the top of the 
window. Below each list name is a blank cell. When you 
enter data in this cell, another cell will appear below it. 
In this way, you can create a list of any length. 

Suppose you wish to store the list {1, 2, 3, 4, 5} in L1. 
Follow these steps:

1. Expand your calculator icon in the calculator pane.

2. Double-click on List in the calculator pane.

3. Click on the cell below L1 and enter 1.

4. Press the down-arrow key to move to a new cell and 
enter 2.

5. Repeat Steps 3-4 with 3, 4, and 5 to complete the 
list.

6. When you are done, click on the Save icon in the 
icon bar.

7. To check your calculator, press Al1E in 

the Home view to see {1, 2, 3, 4, 5}.

8. When you are done, you can close the list editor in 
the editor pane.
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The matrix 
variable editor

Your HP graphing calculator has ten matrix variables, 
named M1-M9 and M0, which can be edited via the HP 
Connectivity Kit. To see the list of matrix variables in the 
HP Connectivity Kit, click on the plus sign icon (+) next to 
the Matrix entry in the calculator pane. Then double-click 
on any of the M0-M9 entries shown to open the matrix 
variable editor for that matrix. 

Suppose you wish to enter the matrix  in M1. Follow 
these steps:

1. Expand your calculator icon in the calculator pane.

2. Click on the plus sign next to Matrix in the calculator 
pane.

3. Double-click on M1.

4. If M1 has data in it, then select the data and press 
the Delete key on your PC keyboard; otherwise, if M1 
has no data, it will open with a zero in M1(1,1).

5. Click on the cell with the zero to see the edit cursor 
and press the Backspace key on your PC keyboard to 
delete the zero.

6. Type 1 and press the Enter key.

7. Use the arrow keys to move from cell to cell and enter 
the values 2, 3, and 4 -or just click on each cell and 
enter its value.

8. When you are done, click on the Save icon in the 
icon bar.

9. To check your calculator, press Am1E in 

the Home view to see [[1, 2], [3, 4]].

10.When you are done, you can close the matrix editor 
in the editor pane. 

You can also collapse the list of matrix variables by 
clicking on the minus sign icon (-) next to the Matrix entry 
in the calculator pane.

1 2
3 4
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The program 
editor

You can create and edit programs for your HP graphing 
calculator using the HP Connectivity Kit. 

Suppose you wish to create a program named X2M1 that 
contains a user-defined function which returns x2-1. 
Follow these steps:

1. Right-click on the Programs entry in the calculator 
pane and select NEW from the context-sensitive menu.

2. Type the name X2M1 and press the ENTER key.

3. Double-click on X2M1 to start the program editor.

4. Enter commands, etc. directly using your PC 
keyboard.

The program editor starts with the following template for 
your program:

EXPORT X2M1()
BEGIN

END;

The EXPORT line exports the name of your user-defined 
function so that it appears in the Commands menu and is 
available throughout your HP graphing calculator. The 
BEGIN…END pair marks the body of the program. You 
will insert your function definition in this pair, using the 
RETURN command.

5. Complete the first line of the program so the user-
defined function takes a real number, X, as input:

EXPORT X2M1(X)

6. In the middle of the BEGIN…END pair (that is, 
between BEGIN and END), define the function:

RETURN X^2-1;

7. When you are done, click on the Save icon in the 
icon bar.

8. To check your calculator, open the Program Catalog 
(press Sx) to see your program listed or 
enter X2M1(8) in the Home view to see the calculator 
return 63.
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12 The HP Connectivity Kit

You may also look in the Commands menu to see your 
new user-defined function. Press Sb to open the 
Commands menu and press the USER menu key ( ) to 
see X2M1 listed as a new function.

For more information on programming your HP graphing 
calculator, see the Programming chapter of the User 
Guide.
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The note editor Your HP graphing calculator can store any number of 
notes, depending on available memory. You can create 
and edit notes for your HP graphing calculator using your 
PC keyboard and the note editor of the HP Connectivity 
Kit. 

To create a note named MYTODOLIST, follow these 
steps:

1. Right-click on the Notes entry in the calculator pane 
and select NEW from the context-sensitive menu.

2. Type in the name MYTODOLIST and press the ENTER 
key.

3. Double-click on MYTODOLIST to start the note editor.

4. Enter the text of your note using your PC keyboard. 

5. When you are done, click on the Save icon in the 
icon bar.

6. To check your calculator, open the Notes Catalog 
(press SN) to see your note listed.

Connectivity_Aspen..fm  Page 13  Wednesday, August 1, 2012  9:08 AM



14 The HP Connectivity Kit

Update the 
HP graphing 
calculator 
software

The HP Connectivity Kit automatically helps you update 
your HP graphing calculator software. This software 
includes all of the built-in HP apps, as well as the list, 
matrix, note, and program editors, etc. It is important to 
update your software whenever there is a newer version 
to give you access to any new features included in the 
latest version. 

1. When you launch the HP Connectivity Kit with your 
HP graphing calculator attached via the USB cable, it 
automatically looks for an update to either the 
Connectivity Kit or your HP graphing calculator 
software. Of course, you can always manually check 
for updates as well by clicking on the File menu and 
choosing the Check for Updates option. If a newer 
version of either is found, you will be prompted to 
install the newer version. Click on the Get It button to 
proceed to download the update(s) or the Not Now 
button to cancel.

2. The Firmware Updater application will go through a 
number of steps. The first step is initialization, shown 
in the figure below. 
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3. Once the Firmware Updater is ready, click on the 
Start button. You will then see a series of messages 
on the progress of the update. This part of the update 
process includes the steps of erasing the old software, 
writing the new software, and verifying. It is important 
that the HP graphing calculator remains connected to 
the PC via the USB cable until the software update 
finishes.

4. When the update process completes, the Firmware 
Updater will close automatically. It is now safe to 
disconnect and use your HP graphing calculator with 
its new software.
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Update 
Manually

If the update process fails at any point, you can update 
the HP graphing calculator software manually. To update 
manually, follow these steps:

1. Your HP graphing calculator came with a USB cable. 
Plug this cable into an available USB port on your 
PC, but do not connect it to your HP Calculator at this 
time.

2. Click on your PC Start menu, navigate to the HP 
Connectivity Kit folder and select Firmware Updater. 

3. The Firmware Update application will launch, but will 
not recognize the attached HP graphing calculator. 
You will see a message, Please connect device, as 
shown in the figure below.
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4. Turn off the calculator. With the calculator off, hold 
down the ON key and re-connect the calculator using 
the USB cable. Keep holding the ON key down until 
the Firmware Updater message changes to 
Initializing… (see figure below). If your HP graphing 
calculator turns back on when you plug in the cable, 
then disconnect and try this step again with the 
calculator turned off.

5. Once your HP graphing calculator is detected and 
Firmware Updater has started initializing the update 
process, you may release the ON key. Once 
initialization is complete, the message changes to 
Ready and the Start button becomes active, as in the 
figure below. If the Ready message does not appear, 
try another USB slot on your PC, or see the section 
titled Format and Update below.

6. Once the Ready message appears, click on the Start 
button to begin the update process.
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7. Once Firmware Updater starts the update process, 
you will see a series of messages on the progress of 
the update (see figure below). This part of the update 
process includes the steps of erasing the old software, 
writing the new software, and verifying. It is important 
that the HP graphing calculator remains connected to 
the PC via the USB cable until the software update 
finishes.

8. When the update process completes, the Firmware 
Updater application will close automatically. It is now 
safe to disconnect and use your HP graphing 
calculator with its new software.
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Resetting your 
HP graphing 
calculator

If your HP graphing calculator freezes (for example, at 
the HP splash screen) or behaves erratically, you should 
try to reset it before updating the software as per the 
previous section. First, try removing and replacing the 
batteries; then turn the calculator back on. This is the 
simplest method and does not erase anything saved in 
memory. If this method does not work, press and hold 
O, 1 and 6 simultaneously. Release the keys 
and the HP graphing calculator should reset to normal. 
This reset method clears variables such as A, L1, and M1, 
etc. Finally, if neither of these methods works, remove 
and replace the batteries. Hold down C while you 
turn the calculator on. When the calculator proceeds past 
the HP splash screen, you can let go of the key. This 
method also clears variables such as A, L1, M1, etc.

Format and 
update

If you experience any difficulty during the update process 
(for example, the HP graphing calculator is disconnected 
during the update process, or your PC shuts down 
unexpectedly during the process) you may need to both 
format and update your HP graphing calculator. To 
format and update your HP graphing calculator, proceed 
with Steps 1-5 of the update process detailed in the 
previous section, Update manually. At Step 6 of that 
process, do not click on the Start button right away. 
Instead, look at the top of the Firmware Updater 
application and find the section titled, Download 
Options. Click on the Format Data Area option, as shown 
in the figure below. 

Once the format option is selected, continue with Steps 7-
8 of the update process, as detailed in the previous 
section. That is, click on the Start button to begin the 
software update. This part of the update process includes 
the steps of erasing the old software, writing the new 
software, and verifying. It is important that the HP 
graphing calculator remains connected to the PC until the 
software update finishes. Once the software update 
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finishes, the Firmware Updater application will close 
automatically. You may now safely disconnect and use 
your HP graphing calculator with its new software.
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